2 курс 4 семестр
Занятие№1
Тема 1: Вступительная беседа векторная и растровая графика.
Тип занятия: лекция, практическая работа.
Цель занятия:
• учебная – научиться различать графические файлы.
• воспитательная - воспитать серьезное отношение к работе у студентов.
• развивающая - развивать кругозор студентов и эстетический вкус.
Литература и учебные пособия:
1. Миронов Д. Ф.,  CorelDRAW 12: Учебный курс. — СПб.: Питер, 2004.
2. Гурский Ю. А., Гурская И. В., Жвалевский А. В. Компьютерная графика: Photoshop CS, CorelDRAW 12, Illustrator CS. Трюки и эффекты. - Санкт-Петербург, видавничий дім «Питер», 2005;
3. Гурский Ю. Компьютерная графика. Трюки и Эффекты /– СПб.: Питер, 2008.
4. 1 .http://corel.demiart.ru/book12/ Иллюстрированный самоучитель по     CorelDRAW 12
5. 2. http://corel-x5.pp.ua/ Иллюстрированный самоучитель по CorelDRAW 15
6. 3.http://www.taby27.ru/studentam_aspirantam/philos_design/referaty_philos_design/style_design.html Проблемы стилеобразования в дизайне
План - конспект занятия
I. Сообщение темы занятия: «Вступительная беседа Векторная и растровая графика».
II. Сообщение цели и задачи занятия.
III. Мотивация учебной деятельности и актуализация опорных  знаний.
IV. Закрепление полученных знаний.
Понятия о существующих графических файлах. Различие создания и редактирования векторных растровых изображений. 
1.Векторные изображения.
Векторным изображением в компьютерной графике принято называть совокупность более сложных и разнообразных геометрических объектов.
2.Растровые изображение.
В терминологии машинной графики пиксельным  изображением принято называть массив пикселей - одинаковых по размеру и форме плоских геометрических фигур, расположенных в узлах регулярной сетки.
3.Цветовые модели.
4.Плюсы и минусы изображений различных видов изображения.
V.  Подведение итогов и выставление оценок.
VI.  Анализ типичных ошибок допускаемых студентами 
VII. Домашнее задание: Понятие о существующих графических моделях  в цифровых файлах, их различие и предпочтения.

Занятие№2
Тема 2: Настройка рабочего пространства CorelDraw.
Тип занятия: лекция, практическая работа
Цель занятия:
• учебная - изучение рабочего пространства графического редактора CorelDraw. 
• воспитательная - воспитать серьезное отношение к работе у студентов.
• развивающая - развивать кругозор студентов и эстетический вкус.


Литература и учебные пособия:
1. Миронов Д. Ф.,  CorelDRAW 12: Учебный курс. — СПб.: Питер, 2004.
2. Гурский Ю. А., Гурская И. В., Жвалевский А. В. Компьютерная графика: Photoshop CS, CorelDRAW 12, Illustrator CS. Трюки и эффекты. - Санкт-Петербург, видавничий дім «Питер», 2005;
3. Гурский Ю. Компьютерная графика. Трюки и Эффекты /– СПб.: Питер, 2008.
4. 1 .http://corel.demiart.ru/book12/ Иллюстрированный самоучитель по     CorelDRAW 12
5. 2. http://corel-x5.pp.ua/ Иллюстрированный самоучитель по CorelDRAW 15
6. 3.http://www.taby27.ru/studentam_aspirantam/philos_design/referaty_philos_design/style_design.html Проблемы стилеобразования в дизайне
План - конспект занятия
I. Сообщение темы занятия: «Настройка рабочего пространства CorelDraw».
II. Сообщение цели и задачи занятия.
III. Мотивация учебной деятельности и актуализация опорных  знаний.
IV. Закрепление полученных знаний.
Изучение рабочего пространства графического редактора CorelDraw. Настройка рабочего пространства под различные запросы пользователя.
1.Панель меню.
2.Панель инструментов.
В расположенной под строкой меню стандартной панели инструментов (toolbar) расположены элементы управления, соответствующие наиболее часто выполняемым командам.
3.Панель палитры цветов.
Вдоль правой границы окна расположена экранная палитра цветов (color palette).  Она применяется для задания цвета заливки и обводки объектов иллюстрации. 
4. Огромную роль в интерфейсе CorelDRAW играют пристыковываемые окна (dockers), в свернутом виде представляющие собой ярлычки с названиями, расположенные слева от экранной палитры цветов. По своим функциям они напоминают диалоговые окна, но в отличие от большинства диалоговых окон могут постоянно присутствовать в рабочем пространстве.

V.  Подведение итогов и выставление оценок.
VI.  Анализ типичных ошибок допускаемых студентами 
VII. Домашнее задание: Научиться настраивать рабочее пространство под различные запросы пользователя.

Занятие№3
Тема 3: Панель инструментов.
Тип занятия: лекция, практическая работа
Цель занятия:
• учебная - изучить панель инструментов и связанную  с ней панель свойств инструментов.
• воспитательная - воспитать серьезное отношение к работе у студентов.
• развивающая - развивать кругозор студентов и эстетический вкус.

Литература и учебные пособия:
1. Миронов Д. Ф.,  CorelDRAW 12: Учебный курс. — СПб.: Питер, 2004.
2. Гурский Ю. А., Гурская И. В., Жвалевский А. В. Компьютерная графика: Photoshop CS, CorelDRAW 12, Illustrator CS. Трюки и эффекты. - Санкт-Петербург, видавничий дім «Питер», 2005;
3. Гурский Ю. Компьютерная графика. Трюки и Эффекты /– СПб.: Питер, 2008.
4. 1 .http://corel.demiart.ru/book12/ Иллюстрированный самоучитель по     CorelDRAW 12
5. 2. http://corel-x5.pp.ua/ Иллюстрированный самоучитель по CorelDRAW 15
6. 3.http://www.taby27.ru/studentam_aspirantam/philos_design/referaty_philos_design/style_design.html Проблемы стилеобразования в дизайне
План - конспект занятия
I. Сообщение темы занятия: «Панель инструментов».
II. Сообщение цели и задачи занятия.
III. Мотивация учебной деятельности и актуализация опорных  знаний.
IV. Закрепление полученных знаний.
Набор инструментов (toolbox). Формально являясь просто одной из множества инструментальных панелей программы, фактически он предназначен выбора рабочего режима и поэтому используется чаще других. Выбор режима осуществляется щелчком мышью на одной из кнопок набора инструментов. С выбора инструментов начинаются практически все действия пользователя над объектами изображения.
Некоторые кнопки инструментов снабжены треугольником в нижнем правом углу. Это - указание, что на самом деле с кнопкой связан не один, а несколько инструментов. Чтобы увидеть их все, вместо быстрого щелчка левой кнопкой мыши ее следует нажать (отпустив только после паузы в одну-две секунды) — на экране раскроется панель конкретного инструмента. 
Панель атрибутов (property bar). Она представляет собой совокупность элементов управления, соответствующих управляющим параметрам выделенного объекта и стандартным операциям, которые можно выполнить над ним с помощью выбранного инструмента. Содержимое панели атрибутов постоянно меняется.
V.  Подведение итогов и выставление оценок.
VI.  Анализ типичных ошибок допускаемых студентами.
VII. Домашнее задание: Изучить связь инструмента с панели инструментов с панелью свойств инструментов. Уметь настроить панель свойств инструментов.

Занятие№4
Тема 4: Создание и модификация объектов.
Тип занятия: практическая работа
Цель занятия:
• учебная – научить создавать и модифицировать объекты Corel Draw.
• воспитательная - воспитать серьезное отношение к работе у студентов.
• развивающая - развивать кругозор студентов и эстетический вкус.

Литература и учебные пособия:
1. Миронов Д. Ф.,  CorelDRAW 12: Учебный курс. — СПб.: Питер, 2004.
2. Гурский Ю. А., Гурская И. В., Жвалевский А. В. Компьютерная графика: Photoshop CS, CorelDRAW 12, Illustrator CS. Трюки и эффекты. - Санкт-Петербург, видавничий дім «Питер», 2005;
3. Гурский Ю. Компьютерная графика. Трюки и Эффекты /– СПб.: Питер, 2008.
4. 1 .http://corel.demiart.ru/book12/ Иллюстрированный самоучитель по     CorelDRAW 12
5. 2. http://corel-x5.pp.ua/ Иллюстрированный самоучитель по CorelDRAW 15
6. 3.http://www.taby27.ru/studentam_aspirantam/philos_design/referaty_philos_design/style_design.html Проблемы стилеобразования в дизайне
План - конспект занятия
I. Сообщение темы занятия: «Создание и модификация объектов».
II. Сообщение цели и задачи занятия.
III. Мотивация учебной деятельности и актуализация опорных  знаний.
IV. Закрепление полученных знаний.
Основой работы с изображением в CorelDRAW являются объекты. Несколько упрощая, можно констатировать следующее: все графические объекты, с которыми приходится иметь дело пользователю этой программы, можно разбить на две категории — линии и примитивы.
1.Линии. Форма линий произвольна и не связана никакими ограничениями, кроме творческого замысла художника.
2.Примитивы. В CorelDRAW имеется несколько классов таких четко определяемых графических  объектов под обобщающим названием примитивы.
3.Создание примитивов.
Создание и модификацию объектов покажем на примере прямоугольника.
Прямоугольники
В частности, в случае с прямоугольниками оказалось, что в эту категорию удобно включить не только хорошо знакомые всем со школьной поры фигуры из четырех попарно ранных отрезков, соединяющихся в конечных точках под прямыми углами, но и производные от них фигуры, у которых один или несколько углов закруглены, то есть представляют собой дугу окружности. Более того, в мире CorelDRAW даже после некоторых преобразований, искажающих форму первоначально прямоугольных объектов, в рамках объектной модели CorelDRAW они по-прежнему считаются прямоугольниками.

4.Модификация примитивов.
V.  Подведение итогов и выставление оценок.
VI.  Анализ типичных ошибок допускаемых студентами.
VII. Домашнее задание: Создание и модификация приметивов при помощи «горячих» клавиш и манипулятора «мышь».

Занятие№5
Тема 5: Создание и редактирование контуров. Итоговое задание.
Тип занятия: практическая работа
Цель занятия:
• учебная - изучение рабочего пространства графического редактора CorelDraw, кривые.
• воспитательная - воспитать серьезное отношение к работе у студентов.
• развивающая - развивать кругозор студентов и эстетический вкус.

Литература и учебные пособия:
1. Миронов Д. Ф.,  CorelDRAW 12: Учебный курс. — СПб.: Питер, 2004.
2. Гурский Ю. А., Гурская И. В., Жвалевский А. В. Компьютерная графика: Photoshop CS, CorelDRAW 12, Illustrator CS. Трюки и эффекты. - Санкт-Петербург, видавничий дім «Питер», 2005;
3. Гурский Ю. Компьютерная графика. Трюки и Эффекты /– СПб.: Питер, 2008.
4. 1 .http://corel.demiart.ru/book12/ Иллюстрированный самоучитель по     CorelDRAW 12
5. 2. http://corel-x5.pp.ua/ Иллюстрированный самоучитель по CorelDRAW 15
6. 3.http://www.taby27.ru/studentam_aspirantam/philos_design/referaty_philos_design/style_design.html Проблемы стилеобразования в дизайне
План - конспект занятия
I. Сообщение темы занятия: «Создание и редактирование контуров. Итоговое задание».
II. Сообщение цели и задачи занятия.
III. Мотивация учебной деятельности и актуализация опорных  знаний.
IV. Закрепление полученных знаний.
Создание контуров при помощи инструментов: свободная форма, кривая Безье, перо и т.д. 
1.Линии (кривые). В этом уроке мы познакомимся с такими классами объектов, как кривая (curve), размерная линия (dimension line), соединительная линия (interactive connector line) и суперлиния (artistic media group). Мы узнаем, как они устроены, и освоим приемы их построения
2. Узлом называется точка на плоскости изображения, фиксирующая положение одного из концов сегмента кривой.
3. Сегментом называется часть кривой, соединяющая два смежных узла.
4.Замкнутые и разомкнутые контура. Узлы и сегменты неразрывно связаны друг с другом: в замкнутой линии узлов столько же, сколько сегментов, в незамкнутой — на один узел больше.
5.Инструменты по созданию контуров. Создаются линии (кривые) при помощи инструментов: Freehand (Свободная форма), Polyline (Ломаная линия, 3-Point Curve (Кривая через 3 точки, Bézier (Кривая Безье), Pen (Перо), Artistic media (Художественное оформление).
V.  Подведение итогов и выставление оценок.
VI.  Анализ типичных ошибок допускаемых студентами.
VII. Домашнее задание: Задание по обрисовке растрового изображения.


Занятие№6
Тема 6: Организация объектов.
Тип занятия: практическая работа
Цель занятия:
• учебная - изучение рабочего пространства графического редактора CorelDraw, перемещение, выравнивание и распределение объектов.
• воспитательная - воспитать серьезное отношение к работе у студентов.
• развивающая - развивать кругозор студентов и эстетический вкус.

Литература и учебные пособия:
1. Миронов Д. Ф.,  CorelDRAW 12: Учебный курс. — СПб.: Питер, 2004.
2. Гурский Ю. А., Гурская И. В., Жвалевский А. В. Компьютерная графика: Photoshop CS, CorelDRAW 12, Illustrator CS. Трюки и эффекты. - Санкт-Петербург, видавничий дім «Питер», 2005;
3. Гурский Ю. Компьютерная графика. Трюки и Эффекты /– СПб.: Питер, 2008.
4. 1 .http://corel.demiart.ru/book12/ Иллюстрированный самоучитель по     CorelDRAW 12
5. 2. http://corel-x5.pp.ua/ Иллюстрированный самоучитель по CorelDRAW 15
6. 3.http://www.taby27.ru/studentam_aspirantam/philos_design/referaty_philos_design/style_design.html Проблемы стилеобразования в дизайне
План - конспект занятия
I. Сообщение темы занятия: «Организация объектов».
II. Сообщение цели и задачи занятия.
III. Мотивация учебной деятельности и актуализация опорных  знаний.
IV. Закрепление полученных знаний.
Перемещение, выравнивание и распределение объектов.
1.Выравние объектов.
Выравниванием называется размещение всех выделенных объектов таким образом, чтобы их определенные точки (например, середины рамки выделения) располагались на одной прямой.
В CorelDRAW предусмотрен мощный инструмент, автоматизирующий выстраивание объектов в ряд вдоль прямой, положение которой задается одним из выравниваемых объектов или страницей документа.
2.Распределение объектов.
 Распределением объектов в CorelDRAW называется размещение объектов, при котором соблюдается равенство расстояний между маркерами их рамок выделения. Добиться этого размещением объектов вручную практически невозможно. Значительно удобнее решать такую задачу с помощью вкладки Distribute (Распределить) диалогового окна Align and Distribute (Выровнять и распределить).
Равномерность при распределении объектов может достигаться двумя принципиально различными способами: равными могут быть расстояния между одноименными маркерами рамок выделения  или интервалы, разделяющие объекты.
V.  Подведение итогов и выставление оценок.
VI.  Анализ типичных ошибок допускаемых студентами.
VII. Домашнее задание: Выбрать три различных по геометрии и объему объекта и распределить относительно рабочей страницы.

Занятие№7
Тема 7: Инструмент «Текст». Итоговое задание.
Тип занятия: практическая работа
Цель занятия:
• учебная - изучение рабочего пространства графического редактора CorelDraw, текст.
• воспитательная - воспитать серьезное отношение к работе у студентов.
• развивающая - развивать кругозор студентов и эстетический вкус.

Литература и учебные пособия:
1. Миронов Д. Ф.,  CorelDRAW 12: Учебный курс. — СПб.: Питер, 2004.
2. Гурский Ю. А., Гурская И. В., Жвалевский А. В. Компьютерная графика: Photoshop CS, CorelDRAW 12, Illustrator CS. Трюки и эффекты. - Санкт-Петербург, видавничий дім «Питер», 2005;
3. Гурский Ю. Компьютерная графика. Трюки и Эффекты /– СПб.: Питер, 2008.
4. 1 .http://corel.demiart.ru/book12/ Иллюстрированный самоучитель по     CorelDRAW 12
5. 2. http://corel-x5.pp.ua/ Иллюстрированный самоучитель по CorelDRAW 15
6. 3.http://www.taby27.ru/studentam_aspirantam/philos_design/referaty_philos_design/style_design.html Проблемы стилеобразования в дизайне
План - конспект занятия
I. Сообщение темы занятия: «Инструмент «Текст». Итоговое задание».
II. Сообщение цели и задачи занятия.
III. Мотивация учебной деятельности и актуализация опорных  знаний.
IV. Закрепление полученных знаний.
Простой и фигурный текст. Вписывание текста в фигуру. Написание текста вдоль направляющей линии. Перевод текста в кривую. 
1.Фигурный текст.
В общем случае фигурный текст представляет собой многоуровневый соединенный объект. Если такой объект выделить, а затем выбрать команду Arrange > Break Apart (Монтаж > Разъединить), после первого разъединения он превращается в совокупность фигурных текстов, каждый из которых соответствует строке исходного фигурного текста. Разъединение строки дает совокупность слов, и только разъединение слова дает совокупность фигурных текстов, каждый из которых будет «элементарным» — разъединить его не удастся, поскольку он состоит из одной младшей структурной единицы текста, символа.
2.Простой текст.
Так же как фигурный, простой текст представляет собой многоуровневый соединенный объект, но уровней, которые простой текст проходит при разъединении, больше, чем у фигурного текста. При разъединении большого объема простого текста могут получаться следующие структурные единицы: колонки текста, пункты перечисления, абзацы, строки, слова, символы. Кроме того, в отличие от фигурного текста простой текст не может располагаться непосредственно на печатной странице. В CorelDRAW любой простой текст располагается внутри особого объекта — рамки простом текста (paragraph text frame). При помощи связен рамки могут образовать составной объект — цепочку рамок простого текста, отдельные элементы которой могут размещаться даже на различных страницах документа CorelDRAW. Базовая форма рамки простого текста — прямоугольник, но в процессе последующих преобразований эти прямоугольники могут принимать произвольные формы.
3. Создание цепочки связанных рамок.
Цепочками связанных рамок простого текста пользуются для того, чтобы разместить одни текстовый фрагмент в нескольких местах одной страницы или на разных страницах документа. Речь идет не о размещении копий, а о продолжении текста при переходе из одной рамки в другую.
V.  Подведение итогов и выставление оценок.
VI.  Анализ типичных ошибок допускаемых студентами.
VII. Домашнее задание: Итоговое задании. Создать портрет знакомого персонажа из текста.

Занятие№8
Тема 8: Заливка объектов и контуров.
Тип занятия: практическая работа
Цель занятия:
• учебная - изучение рабочего пространства графического редактора CorelDraw, заливка цветом.
• воспитательная - воспитать серьезное отношение к работе у студентов.
• развивающая - развивать кругозор студентов и эстетический вкус.

Литература и учебные пособия:
1. Миронов Д. Ф.,  CorelDRAW 12: Учебный курс. — СПб.: Питер, 2004.
2. Гурский Ю. А., Гурская И. В., Жвалевский А. В. Компьютерная графика: Photoshop CS, CorelDRAW 12, Illustrator CS. Трюки и эффекты. - Санкт-Петербург, видавничий дім «Питер», 2005;
3. Гурский Ю. Компьютерная графика. Трюки и Эффекты /– СПб.: Питер, 2008.
4. 1 .http://corel.demiart.ru/book12/ Иллюстрированный самоучитель по     CorelDRAW 12
5. 2. http://corel-x5.pp.ua/ Иллюстрированный самоучитель по CorelDRAW 15
6. 3.http://www.taby27.ru/studentam_aspirantam/philos_design/referaty_philos_design/style_design.html Проблемы стилеобразования в дизайне
План - конспект занятия
I. Сообщение темы занятия: «Заливка объектов и контуров».
II. Сообщение цели и задачи занятия.
III. Мотивация учебной деятельности и актуализация опорных  знаний.
IV. Закрепление полученных знаний.
Настройка окна фонтанной заливки, выбор цвета, настройка окна заливки контура. Заливка сетки, интерактивная заливка, заливка градиентом. 
1.Цвет.
2. Однородные заливки.
Однородной заливкой называется заполнение ограниченного замкнутой кривой объекта цветом, который не меняется в пределах объекта. Чтобы назначить выделенному объекту или нескольким объектам однородную заливку с помощью палитры, достаточно щелкнуть на образце нужного цвета мышью.
3.Заливка градиентом.
В категорию градиентных и сетчатых заливок сведены два класса заливок, обладающих общим признаком: в пределах заливаемого объекта выделяются некие «опорные пункты», для которых фиксируется цвет заливки, а в промежутках между ними цвет «перетекает», плавно меняясь. В полиграфии такие заливки называют цветовыми растяжками. В градиентных заливках в роли «опорных пунктов» выступают точки, прямые, квадраты и окружности, расположенные четко определенным образом (зависящим от типа градиентной заливки).
4.Интерактивная заливка.
5.Заливка контуров.
6.Заливка сетки.
Чтобы построить аналогичную сетчатой заливку другими средствами, потребовалось бы создавать множество отдельных объектов и градиентных заливок, а потом долго и кропотливо подгонять их друг к другу, добиваясь эффекта, с применением сетчатой заливки возникающего автоматически.
При назначении сетчатой заливки объекту произвольной формы на него накладывается сетка, имеющая заранее заданное число «строк» и «столбцов». Сетка состоит из узлов, соединенных линиями. 
V.  Подведение итогов и выставление оценок.
VI.  Анализ типичных ошибок допускаемых студентами.
VII. Домашнее задание:

Занятие№9
Тема 9: Комбинирование объектов.
Тип занятия: практическая работа
Цель занятия:
• учебная - изучение рабочего пространства графического редактора CorelDraw, комбинирование объектов.
• воспитательная - воспитать серьезное отношение к работе у студентов.
• развивающая - развивать кругозор студентов и эстетический вкус.

Литература и учебные пособия:
1. Миронов Д. Ф.,  CorelDRAW 12: Учебный курс. — СПб.: Питер, 2004.
2. Гурский Ю. А., Гурская И. В., Жвалевский А. В. Компьютерная графика: Photoshop CS, CorelDRAW 12, Illustrator CS. Трюки и эффекты. - Санкт-Петербург, видавничий дім «Питер», 2005;
3. Гурский Ю. Компьютерная графика. Трюки и Эффекты /– СПб.: Питер, 2008.
4. 1 .http://corel.demiart.ru/book12/ Иллюстрированный самоучитель по     CorelDRAW 12
5. 2. http://corel-x5.pp.ua/ Иллюстрированный самоучитель по CorelDRAW 15
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План - конспект занятия
I. Сообщение темы занятия: «Комбинирование объектов».
II. Сообщение цели и задачи занятия.
III. Мотивация учебной деятельности и актуализация опорных  знаний.
IV. Закрепление полученных знаний.
Группирование и разгруппирование.
Группированием называется операция, соединяющая совокупность отдельных объектов или ранее созданных групп в группу. Связывание объектов в группу позволяет обращаться с ними как с единым целым, выполняя преобразования группы как преобразование единого объекта.
Соединение и разъединение
Кнопка Combine (Соединить), предназначенная для выполнения этой команды, становится доступной на панели атрибутов после выделения не менее чем двух отдельных объектов. Побочным эффектом действия команды соединения является преобразование всех выделенных объектов в совокупности кривых (которые и становятся ветвями соединенной линии).
Для разъединения соединенной кривой на составляющие ее ветви используется кнопка Break Apart (Разъединить) панели атрибутов. После разъединения каждая ветвь приобретает статус отдельного объекта.
Объединение.
Операция объединения представляет собой удаление пересекающихся частей объединяемых объектов и составление из фрагментов их границ новой границы по линии общего абриса. Участвовать в операции могут два одиночных объекта, одиночный объект и совокупность объектов или две совокупности объектов.
Пересечение.
Операция пересечения создает новый объект из области пересечения двух или более объектов, участвующих в операции. Новый объект наследует атрибуты заливки и обводки «родительского» объекта.
Исключение.
Исключением объектов называется операция, при которой у указанного объекта удаляются части, перекрываемые выделенным объектом. 
V.  Подведение итогов и выставление оценок.
VI.  Анализ типичных ошибок допускаемых студентами.
VII. Домашнее задание: Создать сложный (комбинированный) объект из примитивов используя инструменты комбинирования.

Занятие№10
Тема 10: Спецэффекты.
Тип занятия: практическая работа
Цель занятия:
• учебная - изучение рабочего пространства графического редактора CorelDraw, спецэффекты.
• воспитательная - воспитать серьезное отношение к работе у студентов.
• развивающая - развивать кругозор студентов и эстетический вкус.

Литература и учебные пособия:
1. Миронов Д. Ф.,  CorelDRAW 12: Учебный курс. — СПб.: Питер, 2004.
2. Гурский Ю. А., Гурская И. В., Жвалевский А. В. Компьютерная графика: Photoshop CS, CorelDRAW 12, Illustrator CS. Трюки и эффекты. - Санкт-Петербург, видавничий дім «Питер», 2005;
3. Гурский Ю. Компьютерная графика. Трюки и Эффекты /– СПб.: Питер, 2008.
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План - конспект занятия
I. Сообщение темы занятия: «Спецэффекты».
II. Сообщение цели и задачи занятия.
III. Мотивация учебной деятельности и актуализация опорных  знаний.
IV. Закрепление полученных знаний.
Основное назначение CorelDRAW — создание иллюстративной графики, большинство произведений которой носят плоскостной, подчеркнуто графический характер. Поэтому передавать глубину и объем изображаемой сцены с учетом освещения и направления взгляда приходится чисто графическими приемами, имитируя блики и тени дополнительными объектами, а перспективу — искажением контурных линий объектов.
В CorelDRAW имеются средства для автоматического построения эффектов, имитирующих объемность и глубину сцены. В первую очередь к ним относится преобразование перспективы.
Для построения теней, отбрасываемых предметами на плоскость, можно воспользоваться приемом объединения группы объектов, изображающих фигуру, с последующим изменением заливки и формы полученного объекта, но можно воспользоваться и специальным инструментом для построения падающих теней.
Эффект экструзии позволяет построить на рисунке проекцию обобщенного цилиндра - тела, образующегося при перемещении плоской фигуры в пространстве в направлении, перпендикулярном ее плоскости. CorelDRAW автоматически выполняет параллельное или перспективное проецирование фигуры и строит как изображения боковых поверхностен обобщенного цилиндра, так и светотеневую картину на них.
Пошаговый переход позволяет быстро построить последовательность переходных форм между двумя управляющими объектами, разместить их вдоль заданной траектории, а затем менять внешний вид всех объектов одновременно, редактируя управляющие объекты перехода.
Контуры подобия, представляют собой вариант пошагового перехода с одним управляющим объектом. Семейство подчиненных объектов контура строится как последовательность фигур, близких геометрически к управляющему объекту.
V.  Подведение итогов и выставление оценок.
VI.  Анализ типичных ошибок допускаемых студентами.
VII. Домашнее задание: При помощи инструмента перетекание, преобразование создать из простых фигур ритмичную открытую композицию.

Занятие№11
Тема 11: Экспорт растровых изображений. Печать. Итоговое занятие.
Тип занятия: практическая работа
Цель занятия:
• учебная - изучение рабочего пространства графического редактора CorelDraw.
• воспитательная - воспитать серьезное отношение к работе у студентов.
• развивающая - развивать кругозор студентов и эстетический вкус.

Литература и учебные пособия:
1. Миронов Д. Ф.,  CorelDRAW 12: Учебный курс. — СПб.: Питер, 2004.
2. Гурский Ю. А., Гурская И. В., Жвалевский А. В. Компьютерная графика: Photoshop CS, CorelDRAW 12, Illustrator CS. Трюки и эффекты. - Санкт-Петербург, видавничий дім «Питер», 2005;
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I. Сообщение темы занятия: «Экспорт растровых изображений. Печать. Итоговое занятие».
II. Сообщение цели и задачи занятия.
III. Мотивация учебной деятельности и актуализация опорных  знаний.
IV. Закрепление полученных знаний.
Всего лишь несколько лет назад в 99 случаях из 100 процесс работы над графическим проектом завершался, выводом построенных с помощью CorelDRAW изображений на печать или передачей файлов в бюро полиграфического обслуживания. Неудивительно, что от версии к версии средства CorelDRAW, обеспечивающие подготовку к выводу на печать и саму эту процедуру, постоянно совершенствовались. Сегодня все больше графических работ публикуется в Интернете, и он уже перехватил у полиграфической промышленности пальму первенства в этой области. Отмечайся бурный рост и других технологий электронной. Поэтому сегодня результаты труда компьютерного художника материализуются в одном из трех вариантов: 
- в виде отпечатков, выполненных на монохромных или цветных принтерах, установленных в художественной студии или офисе, где работает художник; 
- в виде файлов с изображениями в различных форматах, предназначеных для интеграции в состав web-страниц, публикации другими электронными средствами или размещения на ftp-серверах в первом случаев качестве дополнения к графическому изображению может разрабатываться так называемая карта - описание активных участков изображения, используемых в качестве ссылок;
- в виде файлов с векторными и точечными изображениями в формате PostScript предназначенных для передачи в бюро полиграфического обслуживания в котором эти файлы выводятся на пленку специальными устройствами.
Экспорт рисунка в файл.
По умолчанию при сохранении рисунка с помощью команды File > Save As (Файл > Сохранить как) создается файл векторного формата CDR — собственного формата программы CorelDRAW. Экспорт рисунка в другой векторный формат можно выполнить с помощью стандартного диалогового окна Save As (Сохранить как), выбрав соответствующую желаемому формату альтернативу в списке Files of type (Тип файла). Однако более универсальным способом экспорта оказывается команда File > Export (Файл > Экспорт), дающая возможность сохранять проект как в векторных, так и в точечных форматах.
V.  Подведение итогов и выставление оценок.
VI.  Анализ типичных ошибок допускаемых студентами.
VII. Домашнее задание: Экспортировать изображение созданное в CorelDRAW, для печати в типографии.
